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1. About Kernel for Access

Welcome to the user manual for Kernel for Access, the most effective and convenient .MDB database 
recovery tool that rebuilds and repairs corrupt Access databases. This user manual comprises step by step 
guidelines on using Kernel for Access. 

1.1 Using this Manual 

This user manual is intended to guide users on using Kernel for Access. We suggest that first time users 
should read this user manual completely and carefully before proceeding to use the software. However, if 
you are an experienced user, you can use the table of contents to find out information pertaining to the 
tasks that you need to perform by using Kernel for Access. You can use the table of contents to navigate 
through different sections of this user manual. The table of contents lists all the sections that are contained 
in this user manual in chronological order. The user manual comprises the following sections: Introduction 

Introduction 

Getting Started  

Software Interface  

Repairing Corrupt Access Database Files 

Full Version  

Support  

Troubleshooting  

Legal Notices  

1.1.1 List of Abbreviations 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

MS: Microsoft  

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

MDB: Microsoft Database  
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1.2 Kernel for Access 

Kernel for Access – Database Repair Software repairs corrupted .MDB database files which get corrupted 
due to unexpected system shutdown, virus attacks or error reading media. Kernel for Access performs 
intensive scan of the corrupted file to determine the intensity of damage and Kernel Access fixes those 
corruption.  Kernel for Access, repairs the damaged databases due to following errors:  

System shutdown unexpectedly 

Virus corruptions   

Media corruptions  

"Unrecognized Database Format"  

"The database needs to be repaired or isn't a database file"  

“The Microsoft Jet database engine could not find the object” 

1.3 Salient Features 

Salient features of Kernel for Access include: 

 Recovers table structure and data  

 Restores key data structures like auto number, primary key, field size and many more 

 Converts MDE database file to MDB database file  

 Restores Memo data, OLE data and Table Relationships  

 Restores Original Date Format  

 Uses Live Preview technology, to retrieve the database structure from the corrupt database and 
displays the Live database preview 

 Recovers password protected Access databases (Even if the password is NOT KNOWN to the 
user) 

 User friendly interface, no technical skills required 

1.4 Who Should Use this Software? 

The capability of Kernel for Access to repair large sized Access databases makes it appropriate for use by 
organizations, individuals and professionals, who are worried due to corruption of their important Access 
database. This corruption could have been caused due to virus attacks, media corruption, unexpected 
system shut down or any other operational error. 
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2. Getting Started

Now that you have understood the features and potential of Kernel for Access, you are ready to get hands 
on experience of the software. To start recovery from corrupt Access database, you will first need to 
download and install this software. It is strongly recommended that before installing Kernel for Access, you 
should go through the installation pre-requisites for the software to ensure that your computer is 
appropriately configured to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Access can be broadly classified into two 
major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 
The hardware requirements for installing the software are as follows: 

Pentium Class Processor 

Minimum 64MB RAM (128 MB recommended)  

10MB for Software installation  

Disk Space - Enough space to store the repaired files 

 You should have at-least 40 MB of free disk space if you want to repair and 
save a 40 MB lost data. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements and MS Access version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

Windows 8 
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Windows 7 

Windows Vista 

Windows XP 

Windows 2003 

Windows 2000 

Windows 98 

Windows 95 

Windows NT 

2.1.2.2 MS Access Version Requirements 

Supported MS Access versions:  

MS Access 2013 

MS Access 2010 

MS Access 2007 

MS Access XP  

MS Access 2003 

MS Access 2000 

MS Access 97  

MS Access 95  
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2.2 Downloading Kernel for Access for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Access, you can 
download and install the software on your computer. You can buy the full version of the software from any 
one of our authorized resellers – Element5, Asknet and 2CO. If you want to try using Kernel for Access 
before buying it, you can download the evaluation version from the following link: 

https://www.nucleustechnologies.com/Download-Access-Databases-Repair-Software.php

 You can repair .MDB files saved on your system by using the evaluation 
version of Kernel for Access; however, the repaired file will not be saved until 
you purchase the full version of the software. 

2.3 Install Kernel for Access 

After downloading the installer file for Kernel for Access, you can install the software by running the file. To 
install Kernel for Access: 

1. Double-click the Kernel for Access installer.

2. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software.

2.4 Start Kernel for Access 

To start Kernel for Access:  

Click the Start All Programs Kernel for Access 

Alternatively, you can launch Kernel for Access by double-clicking the shortcut icon available on the 
desktop and Quick Launch icon. 
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2.5 Uninstall Kernel for Access 

You may need to uninstall and re-install Kernel for OST to PST. You can uninstall Kernel for OST to PST 
in two different ways: 

Uninstall from the Windows Start menu 

You may need to uninstall and re-install Kernel for Access. To uninstall Kernel for Access: 

1. Click the Start All Programs Kernel for Access Uninstall Kernel for Access

A warning message will be displayed. 

2. Click “Yes‟  to uninstall Kernel for Access.

 Before proceeding to uninstall Kernel for Access, you must ensure that the 
software is not running. 

Uninstall from Control Panel 

You can alternatively uninstall Kernel for Access from the Control Panel by performing the following 
steps: 

1. Click the Start Menu > Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Access and click Remove.

A warning message will be displayed. 

3. Click “Yes” to uninstall Kernel for Access.
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3. Software Interface

Now that Kernel for Access has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Access comprises two main menus – File, and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

Figure 3.1.1 File Menu 

Menu items in the File menu: 

Field Name Field Description 

Select Selects the corrupt MDB file for repairing 

Repair Repairs the corrupt MDB file 

Save Saves all repaired files 

Exit Closes Kernel for Access 
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3.1.2 Help Menu 

The Help menu comprises three menu items. 

Figure 3.1.2 Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Displays User’s Help Manual for Kernel for Access 

Software Homepage Guides to  Software homepage on the website 

About Kernel for Access Displays version related information about Kernel for 
Access 

3.2 Tool-bar 

Tool bar consists of buttons that work as short cuts for various options available in the main menus of 
Kernel for Access software. Following table enlists the buttons available on the Tool bar of the software: 

Button Button Name Button Description 

Select File Selects the corrupt Access files 
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Repair File Repairs selected files 

Save File Saves repaired files 

3.3 Buttons Used 

There are several buttons used in the software that help you throughout the recovery process. Following 
table lists the buttons used in the software 

Button Button Description 

Selects the MDB file for repairing 

Starts the repairing process 

Stops the repair process 

Saves the repaired MDB file 

To navigate back during the repair process 
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4. Repairing Corrupt Access Database Files

Now that you have complete familiarity of the user interface of Kernel for Access, you are ready to 
repair .mdb files. To repair .MDB files: 

1. Launch Kernel for Access. Two modes of repairing are provided: Standard Mode and Template
Mode.

Figure 3.3.1 Welcome Screen 

 Template mode is suitable when your data and table structure are corrupt and 
you have backup of the corrupt file but the backup file is not updated or does 
not contain complete data. Using Template Mode, Kernel for Access repairs 
data and table structure more efficiently. 
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2. Select Standard Mode and browse for the corrupt Access database file by clicking Select File
button. Click the Repair button when the selected file will gest displayed in the software

Figure 3.3.2 Standard Mode 
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Note: When you select the Template Mode, the extra text field with Select File button will appear to 
select the backup file. Select the corrupt Access database file and the backup file, and click Repair button. 

Figure 3.3.3 Template Mode 
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3. Software will start the repair process and will display all the items of the repaired file. Click the Save
button to save the repaired file, and then browse for the saving location.

Figure 3.3.4 Repaired File 
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4. On successful saving software will display link of the location of the saved file. Click the location link
to view the saved Access database file.

Figure 3.3.5 Saved Location 
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9. Full Version

Although you can use Kernel for Access evaluation version for free and experience the capabilities of the 
software, there are certain features that are not available in the evaluation version. 

9.1 Requirement of Full Version 

By using the evaluation version of Kernel for Access, you can view the preview of the database and can 
get idea about how many tables and records can be recovered from the database. This way you can verify 
with the demo version if it will repair your corrupt access database. You will need to buy the full version of 
the software to perform complete repairing process. 

9.2 Purchasing Full Version 

You can buy the full version of Kernel for Access from any one of our authorized resellers – Element5, 
Asknet and 2CO. As soon the purchase transaction with our resellers gets completed, our sales team will 
send you an email comprising the URL to download the full version of Kernel for Access and activation 
details of the software. 
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10. Support

We have an extensive and efficient support system in place to assist our customers with all 
issues related to using Kernel for Access. The software comes with an embedded help manual 
that can be accessed by clicking HelpSoftware Help in the menu-bar. You can also press the 
F1 key on the keyboard of your computer to access the embedded help of Kernel for Access.  

You can access the online help for Kernel for Access at 
https://www.nucleustechnologies.com/userguide/Kernel_for_Access.pdf

You can access the online help for Kernel for Access at 
https://www.nucleustechnologies.com/userguide/Kernel_for_Access.pdf

View Animated Working Demo of the software at 

https://www.nucleustechnologies.com/accessdatabaserepair/animatedmdb.html

We also have live support wherein you can chat with our software experts 
at https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call: 

Help line: 

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 
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11. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Access. 

11.1 Common Issues 

Why does Kernel for Access have limitations in evaluation copy? The free evaluation version of 
Kernel for Access is intended to enable you to experience the capabilities of the software. You will need to 
buy the software save the recovered data.  

11.2 Frequently Asked Questions 

How to Buy Kernel for Access? 
You can buy Kernel for Access online at https://www.nucleustechnologies.com/Buy-Access-Databases-
Repair-Software.php 

I have lost my full version for Kernel for Access. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 
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12. Legal Notices

This section comprises the legal specification about Kernel for Access and the company 
KernelApps Private Limited  

12.1 Copyright 

KernelApps Private Limited, Kernel accompanied user manual and documentation are copyright of 
KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot 
be reproduced in any form without the prior written permission of KernelApps Private Limited. No Patent 
Liability is assumed, however, with respect to the use of the information contained herein. 

© KernelApps Private Limited. All rights reserved. 

12.2 Trademark 

Kernel ® is a copyright work of KernelApps Private Limited 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and Open Office 
are registered trademarks of Microsoft Corporation and Sun Microsystems, Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

12.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. KernelApps Private Limited provides no warranty with regard to this manual or 
any other information contained here in and here by expressly disclaims any implied warranties of 
merchantability or fitness for any particular purpose with regard to any of the foregoing KernelApps 
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or 
typographical errors or omissions contained here in or for discrepancies between the product and the 
manual. In no event shall KernelApps Private Limited, be liable for any incidental, consequential special, 
or exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with 
this manual or any other information contained here in or the use there of. 

12.4 License Agreement 

Kernel for Access Copyright © by KernelApps Private Limited Your 

Agreement to this License 
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You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by KernelApps Private Limited. The terms 
and conditions of this License describe the permitted use and users of each Licensed Copy of Kernel for 
Access. For purposes of this License, if you have a valid license, you have the right to use a single 
Licensed Copy of Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Access may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Kernel, which are not expressly granted in this License, are entirely and exclusively 
reserved to and by KernelApps Private Limited. You may not rent, lease, modify, translate, reverse 
engineer, decompile, disassemble, or create derivative works based on, Kernel, nor permit anyone else to 
do so. You may not make access to Kernel available to others in connection with a service bureau, 
application service provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Access, and any and all accompanying software, files, data and materials, are distributed and 
provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there is no 
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates 
that any program, including Kernel, must be thoroughly tested with non-critical data before there is any 
reliance on it, and you hereby assume the entire risk of all use of the copies of Kernel covered by this 
License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no event 
does KernelApps Private Limited authorize you or anyone else to use Kernel for Access in applications or 
systems where Kernel for Access failure to perform can reasonably be expected to result in a significant 
physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold 
KernelApps Private Limited harmless from any and all claims or losses relating to such unauthorized use.  

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by KernelApps Private Limited herein. 

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same 
provision, or any other provision, of this License. 


